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Version 1.2
Before You Begin

Estimated time to complete this lab

90 minutes
Objectives

After completing this lab, you will be able to:

· Create Decision Tree and Naïve Bayes data-mining models.
· View mining accuracy charts.
· Create a prediction query.
· Create a Time Series model.
Prerequisites

Before working on this lab, you must have:

· A general understanding of data-mining concepts and terminology.
· A general familiarity with Microsoft SQL Server® Business Intelligence Development Studio.
· A general familiarity with SQL Server Management Studio.
Lab Setup

Lab scenario
Adventure Works Cycles, a bicycle manufacturing company, uses business analytics to better understand its customer base. The company plans to analyze and improve the performance of its bicycle retail sector. Over time, the company has collected information about past customers and sales. It now wants to use this information to gain insights about its customers.
Virtual PC

This lab makes use of Microsoft Virtual PC 2007, which is an application that allows you to run multiple virtual computers on the same physical hardware. During the lab, you will use a virtual machine running Windows Server® 2003.
Before you start the lab, familiarize yourself with the following basics of Virtual PC:

· To switch the focus for your mouse and keyboard to the virtual machine, click inside the virtual machine window.

· To remove the focus from a virtual machine, move the mouse pointer outside the virtual machine window.

· To mimic the CTRL+ALT+DELETE key combination inside a virtual machine, use RIGHT-ALT+DELETE. In Virtual PC, the RIGHT-ALT key is called the host key.

· To enlarge the size of the virtual machine window, drag the lower-right corner of the window as seen in the screenshot.
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· To switch to and from full-screen mode, press RIGHT-ALT+ENTER.

Computers in this lab

This lab uses one computer as described in the following table. Before you begin the lab, you must start the virtual machine and then log on to the computer. In each exercise, you only have to start the virtual machine that is needed.

	Virtual Machine
	Computer Name
	User Name
	Password

	SQL Server 2008 HOLs
	MIAMI
	Student
	Pa$$w0rd


Start the virtual machine
1. Launch Microsoft Virtual PC from the Start menu or desktop. If the Virtual PC console does not appear, double-click its icon in the notification area.
2. Select SQL Server 2008 HOLs, and then click Start.

3. When the virtual server is running, in the virtual server window, on the Action menu, click Ctrl+Alt+Del (or press RIGHT-ALT+DELETE on your keyboard) to send a CTRL+ALT+DEL sequence to the logon dialog box within the virtual server window.
4. Type the following information, and then click OK:

· User name: Student
· Password: P@ssw0rd
Exercise 1: Creating Data Mining Models
In this exercise, you will develop an Analysis Services solution by using the Microsoft Business Intelligence Development Studio environment. Business Intelligence Development Studio is an environment based on the Microsoft Visual Studio® environment. Business Intelligence Development Studio provides an integrated development environment for designing, testing, editing, and deploying projects to an Analysis Services instance. You will create and view a data mining structure with Decision Trees and Naïve Bayes data mining models.

SQL Server 2008 Analysis Services provides enhanced data mining functionality through the following data mining techniques:

· Microsoft Association Rules

· Microsoft Clustering

· Microsoft Decision Trees

· Microsoft Naïve Bayes

· Microsoft Neural Network

· Microsoft Sequence Clustering

· Microsoft Time Series
· Microsoft Text Mining

· Microsoft Linear Regression

· Microsoft Logistic Regression

Create views in the AdventureWorksDW database
5. Click Start, and then click Computer.

6. Browse to the C:\SQLHOLS\Data Mining\Starter folder.
7. Double-click Setup.cmd.
8. Wait for the Command Prompt window to close before proceeding to the next procedure.
Create an Analysis Services project
9. Start SQL Server Business Intelligence Development Studio.
10. On the File menu, point to New, and then click Project.

11. In the New Project dialog box, in the Project Types pane, click Business Intelligence Projects.

12. In the Templates pane, click Analysis Services Project.
13. In the Name box, type DM Exercise 1
14. In the Location box, type C:\SQLHOLS\Data Mining\Starter\
15. Clear the Create directory for Solution checkbox, and then click OK.

Note: The project is created in a new solution. A solution is the largest unit of management in the Business Intelligence Development Studio environment. Each solution contains one or more projects. An Analysis Services project is a group of related files that contain the XML code for all of the objects in an Analysis Services database.

You can view the solution and its projects in the Solution Explorer window on the right-hand side in Business Intelligence Development Studio. If Solution Explorer is not visible, you can view it by selecting the View, Solution Explorer menu item (or the keyboard shortcut CTRL+ALT+L).
16. In Solution Explorer, right-click the DM Exercise 1 project, and then click Properties.

17. In the DM Exercise 1 Property Pages dialog box, under Configuration Properties, click Deployment.
18. In the right pane, in the Deployment Mode drop-down list, click DeployAll, and then click OK.

Note: You can configure the build, debugging, and deployment properties of an Analysis Services project.

Create a data source

19. In Solution Explorer, under the DM Exercise 1 project, right-click the Data Sources folder, and then click New Data Source.

20. In the Data Source Wizard dialog box, on the Welcome to the Data Source Wizard page, click Next.

21. On the Select how to define the connection page, ensure that the Create a data source based on an existing or new connection option is selected, and then click New.

22. In the Connection Manager dialog box, in the Provider drop-down list at the top of the page, click SqlClient Data Provider in the .Net Providers folder, and then click OK.
23. In the Server name box, type (local)
24. Under Log on to the server, click Use Windows Authentication.
25. In the Select or enter a database name drop-down list, click AdventureWorksDW.

26. Click Test Connection, and then click OK to dismiss the message box.

27. In the Connection Manager dialog box, click OK.

28. In the Data Source Wizard dialog box, on the Select how to define the connection page, verify that (local).AdventureWorksDW is selected, and then click Next.

29. On the Impersonation Information page, select Use the service account, and then click Next.

30. On the Completing the Data Source Wizard page, leave the default data source name Adventure Works DW unchanged, and then click Finish.

You have now set up the connection information for the database. You must now define the schema information that you want to use in the solution. You do this by creating a Data Source View.

Create a Data Source View
31. In Solution Explorer, under the DM Exercise 1 project, right-click the Data Source Views folder, and on the shortcut menu, click New Data Source View.

32. In the Data Source View Wizard dialog box, on the Welcome to the Data Source View Wizard page, click Next.
33. On the Select Data Source page, in the Relational data sources pane, verify that Adventure Works DW is selected, and then click Next.
Note: At this point, Analysis Services may take a few moments to read the database schema.
34. In this project, the Data Source View is not based on a table; instead, it is based on a view. On the Select Tables and Views page, double-click vDMLabCustomerTrain to add this view to the Included objects list, and then click Next.
Note: You may need to expand the Name column, or the entire dialog box, to be able to select vDMLabCustomerTrain.
35. On the Completing the Wizard page, in the Name box, type Customers and then click Finish. The Data Source View Designer will open. The Data Source View Designer is a graphical representation of the data schema that you have defined.
36. Right-click the vDMLabCustomerTrain table, and then click Explore Data.
Note: Analysis Services may take a few moments to read the data.

37. This opens a new window in which you can view the data for the table. If you want, you can make the tab into a dockable floating window instead. To do this, right-click the window tab, and then click Floating or Dockable.
38. In the Explore vDMLabCustomerTrain Table window, click the Chart tab.

Note: The values in the charts show the relationship between the number of records sampled for different properties. These values are based on the sampling that was taken when you clicked Explore Data. You can configure if the sampling should come from the first rows returned or from random rows. You can also configure how many rows you want to sample.
39. In the Explore vDMLabCustomerTrain Table window, click the Table tab, scroll to view the data, and then close the Explore VDMLabCustomerTrain Table window.
Create a Data Mining Structure with a Decision Trees mining model
40. In Solution Explorer, under the DM Exercise 1 database, right-click the Mining Structures folder, and then click New Mining Structure.

41. In the Data Mining Wizard, on the Welcome to the Data Mining Wizard page, click Next.
Note: The Data Mining Wizard is the starting point for all data mining operations.

42. On the Select the Definition Method page, select From existing relational database or data warehouse, and then click Next.
43. On the Create the Data Mining Structure page, under Create mining structure with a mining model option, verify that Microsoft Decision Trees is selected, and then click Next.
44. On the Select Data Source View page, in the Available data source views pane, verify that the Customers data source view is selected, and then click Next.
45. On the Specify Table Types page, in the Input tables pane, in the vDMLabCustomerTrain row, verify that the Case check box is selected, and then click Next.
46. On the Specify the Training Data page, in the Mining model structure pane, select or deselect each cell by selecting or clearing the check box as shown in Figure 1, and then click Next.
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Figure 1
Because CustomerKey is the primary key of the source table, the Data Mining Wizard has automatically selected it as the key. The key identifies the cases in the mining model. The attributes selected as Input are analyzed to determine their relationship and influence on the attribute selected as Predictable.
Important: The CustomerKey, FirstName, and LastName columns must not be selected as Input or Predictable columns.

47. On the Specify Columns’ Content and Data Type page, review the Content Type column for all numeric rows, and then click Detect.

48. When the detection is complete, notice that the NumberCarsOwned and NumberChildrenAtHome fields have been changed from Continuous to Discrete, and then click Next.
Note: The Content and Data Type page shows the Data Type determined from the source data. When you click Detect, Analysis Services scans numeric fields to determine if they are continuous or discrete data. After the detection has occurred, the interface provides you with the flexibility to manually edit both the Data Type and Content Type fields.

49. On the Split data into training and testing sets page, ensure that Percentage of testing data is set to 30%, and then click Next.

Note: SQL Server 2008 Analysis Services enables you to partition your input data into training and testing sets of data. The training data will be used by the mining model algorithm to determine patterns and relations. A randomly selected portion of the data will be held to test the accuracy of the data mining models created by comparing model predictions to actual values. All mining models associated with this mining structure will use the training and testing sets defined in this step.
50. On the Completing the Wizard page, in the Mining Structure Name box, type Customers, select the Allow drill through check box, and then click Finish. The Mining Structure designer will open.
Note: A data mining structure can contain multiple data mining models. Each data mining model uses a subset of the data referenced by the data mining structure. When the data mining structure is processed, the source data is queried once and then all of the data mining models are processed in parallel.

Modify the mining model

In the following procedures, you will add mining models to the Customers mining structure. To make it easier to identify the different models in this mining structure, you will rename the existing mining model. You can rename the model on the Completing the Wizard page of the Data Mining Wizard, or at any time through the Mining Model properties.
51. Select the Mining Models tab to view information about the model.

52. In the Mining Models grid, right-click the second column’s heading, and then click Properties.

53. In the Properties window, in the Name property box, type Customers DT to rename the mining model, and then press ENTER.

Note: Step 3 renames the Decision Tree mining model but does not rename the mining model structure.

Create a filtered mining model

In this procedure, you will create a filtered model based on the Australia region. By creating this model, you will be able to compare and contrast buying patterns worldwide with those in Australia.
54. In the Mining Models tab, click anywhere in the Customers DT model.

55. Click the Create a related mining model button on the toolbar in the Mining Models tab.
56. In the New Mining Model dialog box, in the Model Name box, type Australia Customers DT and click OK.
57. Verify that all of the columns for the Australia Customers DT model are set to Input except for the Bike Buyer and Customer Key columns. Bike Buyer must be set to PredictOnly and Customer Key must be set to Key.

58. Right-click the Australia Customers DT model, and then click Set Model Filter.

59. On the [Australia Customers DT] Model Filter page, in the first row, in the Mining Structure Column box, select English Country Region Name, verify that the Operator is = , and in the Value column, type Australia. Then click OK.
Modify the mining structure

In the following procedures, you will modify your mining structure to improve the format of the input data to support the Naïve Bayes algorithm. Continuous data values are not used by the Naïve Bayes algorithm. Because we believe age and yearly income are significant attributes to consider, we will add additional columns to the data structure and discretize (create discrete groups of data from the continuous data) the columns to allow the Naïve Bayes algorithm to utilize these columns. However, if these columns were not relevant to our analysis, the flexibility of the mining structure means that the Yearly Income and Age columns can be ignored in the Naïve Bayes mining mode and still be utilized in the Decision Tree model. Models are not required to be consistent.
Tip: You should create numerous mining models that are based on different algorithms and then test the accuracy of the models. Depending on your data and the information that you want to determine from this data, the different algorithms will provide differing insights and accuracy. In Exercise 2, you will create and view accuracy charts to compare the results from different models.
60. In the Customers.dmm designer, click the Mining Structure tab.

61. In the Mining Structure tree view on the left side of the designer window, right-click the Customers structure, and then click Add a Column.

62. On the Select a Column page, click Age, and then click OK. In the Microsoft Visual Studio warning box that appears, click Yes to continue.

63. In the Mining Structure tree view on the left side of the designer window, right-click the Customers structure, and then click Add a Column.

64. On the Select a Column page, click Yearly Income, and then click OK. If the Microsoft Visual Studio warning box appears, click Yes to continue.

65. In the Mining Structure tree view on the left side of the designer window, right-click the Age 1 column, and then click Properties.

66. In the Basic section, change the Name to Age Discretized and then press ENTER. In the Microsoft Visual Studio warning box that appears, click Yes to change the name in all related mining model columns.

67. In the Data Type section, in the Content box, select Discretized, and then verify that the DiscretizationMethod is set to Automatic.
68. In the Mining Structure tree view on the left side of the designer window, right-click the Yearly Income 1 column, and then click Properties.

69. In the Basic section, change the Name to Income Discretized and then press ENTER. In the Microsoft Visual Studio warning box that appears, click Yes to change the name in all related mining model columns.
70. In the Data Type section, in the Content box, select Discretized, and then verify that the DiscretizationMethod is set to Automatic.
71. In the Mining Structure tree view on the left side of the designer window, right-click the Number Cars Owned column, and then click Properties.

72. On the Properties page, in the Content box, verify that Discrete is selected.

73. In the Mining Structure tree view on the left side of the designer window, right-click the Number Children At Home column, and then click Properties.

74. On the Properties page, in the Content box, verify that Discrete is selected.

Note: You can also discretize the original Age and Yearly Income columns. This change would be reflected in all models including the Decision Trees model created earlier in the exercise. Discretizing data may cause the model predictions to change. You must carefully review your data and test multiple approaches to determine the most effective approach.
Create a Naïve Bayes mining model

75. In the Customers.dmm designer, click the Mining Models tab.

76. Click the Create a related mining model button on the toolbar in the Mining Models tab.
77. In the New Mining Model dialog box, in the Model Name box, type Customers NB
78. In the New Mining Model dialog box, in the Algorithm Name drop-down list, click Microsoft Naive Bayes, and then click OK.

79. When the alert appears to confirm that you want to use the Microsoft Naive Bayes algorithm and that some columns will be ignored, click Yes to approve and dismiss the dialog box.
Note: The Naïve Bayes algorithm does not use continuous columns. Therefore, the Yearly Income and Age continuous columns will be ignored in this mining model, but they will continue to be utilized in the Decision Tree model. You will use the Age Discretized and Income Discretized columns for this model.
80. In the Customers NB column, click in the Age Discretized cell (the content is currently Ignore), and in the cell drop-down list, select Input.
81. In the Customers NB column, click in the Income Discretized cell (the content is currently Ignore), and in the cell drop-down list, select Input.
Deploy the Analysis Services solution

82. On the Build menu, click Deploy DM Exercise 1.
83. Observe the deployment progress shown in the Deployment Progress pane (normally on the right side of Business Intelligence Development Studio). The Deployment Progress pane gives you detailed information about what happens during deployment.

Note: Analysis Services might take a while to process the data mining models.

In the previous procedures, various wizards and editors have created XML code based on your input. Deployment sends the XML code to the Analysis Server and then processes the Analysis Services database.
View the Decision Trees mining model decision tree
84. Click the Mining Model Viewer tab.

Note: If an alert appears indicating that changes have been made, click No.
85. In the Mining Model drop-down list, click Customers DT.

86. On the View menu, click Full Screen (or press SHIFT+LEFT-ALT+ENTER) to display the designer window in full screen view. Repeat this process to return to normal view.
Tip: If you accidentally close the Mining Model Viewer of the Mining Model Designer, you can re-open it. Select the View, Solution Explorer menu item. In the Solution Explorer window, under the Mining Structures folder, right-click Customers.dmm, and on the shortcut menu, click Browse.
87. In the Tree drop-down list, ensure that Bike Buyer is selected.
88. If the entire decision tree is not visible, the Navigation pane can be used to select the area of the tree that you want to view. In the lower-right corner of the Mining Model Viewer, click and hold on the small + button in the lower-right corner of the Mining Model Viewer. The mouse pointer will change to a cross-arrow icon and the Navigation window will appear. You may drag the mouse to navigate within the Mining Model Viewer. Figure 2 shows the location of the navigation button (it is highlighted in a circle). You may need to use the scroll bars (highlighted in a rectangle) to see the + button.
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Figure 2
Tip: The Mining Legend window on the right side of the display may be relocated and resized to improve the display of the decision tree. If you accidentally close the Mining Legend window, click the Refresh icon next to the Viewer box and the Mining Legend window will return.
89. On the Show Level slider, drag the pointer to the left so that only one level of the decision tree is displayed.

90. Click the All node. This node contains a histogram with blue representing bike buyers and red representing non-bike buyers.

Information about all customers is displayed in the Mining Legend window. Review the values showing how many customers are bike buyers. Compare the percentage of bike buyers to non-bike buyers. (You may need to widen the Mining Legend window to be able to see the percentages.)
91. On the Show Level slider, drag the pointer to the right so that two levels of the decision tree are displayed. Note that Age is most predictive of a customer's bike buying behavior.

92. Click each node of level 2. The Mining Legend window displays detailed information for each node.

93. In the Background drop-down list, click Yes.
The shade of each node indicates the concentration of the value in the Background drop-down list. The dark blue color tells you that the greatest number of bike buyers were between 34 and 41 years old.
94. Double-click the + to the right of the Age >=34 and <41 box. Again, the dark blue coloring shows that most bike buyers had zero or one car. Expand and contract nodes in the diagram to investigate the predicting factors for each group.
View the Decision Trees mining model dependency network

95. In the Mining Model Viewer, click the Dependency Network tab.
The Dependency Network viewer displays the strength of the relationships between the attributes in a decision tree model.

96. On the Links slider, drag the pointer to the bottom. As the threshold for links becomes higher, dependencies are removed from the chart.

Note: The strongest link is shown to be Age as previously shown on the Decision Tree tab.

97. In the Dependency Network diagram, click the Bike Buyer node.
The color of each node indicates that attribute's relationship to the Bike Buyer attribute.
98. On the Links slider, slowly drag the pointer up to the top. As you drag the pointer upward, the relationships within the data are displayed according to the strength of the dependency.
Review the filtered mining model
99. In the Mining Model drop-down list, click Australia Customers DT.

100. Use the steps documented in the previous two procedures to review the Decision Tree and Dependency Network information for the Australia Customers DT model. Notice that in Australia, the number of cars owned is the most predictive attribute and age is one of the weaker links.
Review the Naïve Bayes mining model
101. In the Mining Model drop-down list, click Customers NB to view the Naïve Bayes mining model.

102. Select the Attribute Profiles tab

103. In the Predictable drop-down list, ensure that Bike Buyer is selected.
104. If necessary, move the Mining Legend window to view and explore the attribute profiles. The Attribute Profiles tab displays the attributes that impact the state of the predictable value selected.
105. Click the bar chart where the Yes column and the Commute row intersect. The Mining Legend window now displays the distribution of commute miles among those cases where the value of Bike Buyer is Yes.
106. Click the Attribute Characteristics tab.

107. In the Attribute drop-down list, ensure that Bike Buyer is selected, and in the Value drop-down list, click Yes.

The characteristics of bike buyers, ordered by their frequency, are displayed.

108. In the Value drop-down list, click No.

Notice that the characteristics of non-bike buyers are different from the characteristics of bike buyers.
Note: On the Characteristics tab, a high percentage of probability does not necessarily mean a strong correlation. It is the difference in probability between the various possible values of each attribute that indicates the correlation. Marital status has only two options (married or single). For bike buyers, the probability of 50.627 percent for married verses 49.373 percent for single is not a significant factor. However, for non bike buyers, marital status is more significant. 56.940 percent of non-bike buyers were married and 43.060 percent were single.

109. Click the Attribute Discrimination tab.

110. In the Attribute drop-down list, ensure that Bike Buyer is selected.

111. In the Value1 drop-down list, click Yes.

112. In the Value 2 drop-down list, click No. The attribute values that impact a customer's bike-buying decision are displayed. The attribute values are ordered by how strongly they favor bike buyers or non-bike buyers. For example, people from Australia are more likely to be bike buyers; however, people who have to commute over 10 miles to work are more likely to be non-bike buyers.
113. Select different bars under Favors Yes and Favors No, and then review the values in the Mining Legend.

114. Click the Dependency Network tab.

115. On the Links slider, drag the pointer to the bottom.

116. In the Dependency Network diagram, click the Bike Buyer node. The color of each node indicates that attribute's relationship to the Bike Buyer attribute.

117. On the Links slider, slowly drag the pointer up to the top. As you drag the pointer upward, the relationships within the data are displayed.
Note: Note that fewer nodes are visible for the Customer NB model. This is because there are fewer input values in the model. All continuous data types were ignored by the model.

118. On the File menu, click Close Project. If prompted to save changes, click Yes.

Exercise 2: Viewing Mining Accuracy Charts
In this exercise, you will validate mining models by using the Mining Accuracy Chart view and a cross-validation report. These validation tools enable you to determine which model will provide you with the most accurate view of your data.
Note: This exercise requires the views that were created at the beginning of exercise 1.

Open and deploy an existing project

119. Open Business Intelligence Development Studio if it is not already open.

120. On the File menu, point to Open, and then click Project/Solution.

121. In the Open Project dialog box, browse to C:\SQLHOLS\Data Mining\Starter\DM Exercise 2, click DM Exercise 2.sln, and then click Open.

Important: The solution used in Exercise 2 is different from the solution created in Exercise 1.
122. On the Build menu, click Deploy DM Exercise 2.

123. Observe the deployment progress shown in the Deployment Progress pane. The Deployment Progress pane gives you detailed information about what happens during deployment.
Note: Analysis Services might take a while to process the data mining models.

124. When deployment is complete, you can close the Deployment Progress window if you want.

Define the data and models to test
To test the accuracy of your models, you must select the mining models that you want to view along with the predictable column name, the value you want to predict, the data set to be used for analyzing the results, and any filters to be applied to the data.

125. In Solution Explorer, expand the Mining Structures folder, and then double-click Customers.dmm.

Tip: If Solution Explorer is not visible, click View, and then click Solution Explorer.

126. Click the Mining Accuracy Chart tab.
127. Verify that the Synchronize Prediction Columns and Values box is selected.

Tip: You should only clear the Synchronize Prediction Columns and Values box if you know that two mining structure columns derive from the same underlying relational or multidimensional source and the columns contain the same states or have been discretized in the same way. In this scenario, you will enable Analysis Services to synchronize the columns and values because all columns may not be discretized in the same way.
128. On the Input Selection page, in the Select predictable mining model columns to show in the lift chart section, verify that the Show check box is selected for both the Customers DT and Customers NB mining models.

129. In the Predictable Column Name column, verify that Bike Buyer is selected for both mining models.

Note: In the Predictable Column Name drop-down lists, the mining model column names are restricted to columns that have their usage type set to Predict or Predict Only.

130. In the Select data set to be used for Accuracy Chart area, select Specify a different data set, and then click the ellipsis. The Specify Column Mapping page opens. You will use the Column Mapping page to design a Prediction Query that will be run to compare the mining model's predicted values with the validation data set's actual values.

131. On the Column Mapping page, in the Select Input Table(s) window, click Select Case Table.

132. In the Select Table window, verify that Customers is selected in the Data Source drop-down list, click the vDMLabCustomerValidate table, and then click OK.

Relationships between the mining structure and the input table are automatically created between columns with the same name. Relationships can be added or deleted by the user.
133. On the Specify Column Mapping page, click OK.

134. In the Predict Value column, in the drop-down list, click Yes for both mining models.
View a lift chart

135. Click the Lift Chart tab. The prediction query designed on the Column Mapping page will be run. The prediction query will return a prediction for each case in the validation data set. The lift chart enables you to compare the validity of models side-by-side, as well as to the ideal model (which represents the actual values) and the random-guess model.
Note: The mining model will have greater confidence in its prediction for some cases than for others. For each case, the prediction query will also return the probability that the prediction is correct.

The cases are sorted by the probability that the prediction is correct, and the percentages of correct predictions are then displayed on the lift chart.
136. Point to any of the lines on the chart to display a tooltip showing information relevant to the location on the line.

Tip: The Mining Legend window opens automatically when the Lift Chart tab is selected. Values in the legend change when you click different areas within the lift chart.
137. Click the area of the lift chart where the Customers DT model has a Target Population of 90%.

138. Notice that at the top of the mining legend, it states that the Population percentage is 70.00%. This means that the Customers DT model needs to select only approximately 71% of the customers to identify 90% of the bike buyers.
139. Repeat this process for the Customers NB, Ideal, and Random Guess models.
· The Ideal model needs to select only approximately 45% of the customers to identify 90% of the bike buyers.

· The Customers NB model needs to select approximately 85% of the customers to identify 90% of the bike buyers.

· The Random Guess model needs to select approximately 90% of the customers to identify 90% of the bike buyers.

Note: Because the Customers DT mining model needs to select fewer cases to identify a specified percentage of bike buyers, it would be deemed more accurate than the Customers NB model.
Perform cross-validation

140. Click the Cross Validation tab. Cross-validation provides another method that you can use to test and view the accuracy of your mining models. With cross-validation, your data is partitioned into cross-sections that are used to interactively train and test models against each other cross-section. One portion of the data is used to test the data, and the remaining data is used to train the model.
141. On the Cross Validation page, set the Fold Count to 2, Max Cases to 500, and Target Attribute to Bike Buyer, and in the Target State box, type Yes and then click Get Results.
Note: The Fold Count defines the number of folds or partitions that the data is broken into for testing. The Max Cases value defines the maximum number of cases, or rows in a relational data set, across all folds that can be analyzed and tested. If the Max Cases value is set to 0, the entire dataset defined in the structure will be used. By increasing the Fold Count and Max Cases values, you can see how larger data sets will affect the accuracy of your models. Increasing the Fold Count and Max Cases values will increase the time and resources required to generate the report.
The Cross-Validation report provides numerous statistical values to provide you with information about the accuracy of the different models that you have chosen.
The first section of the report is for the Customers DT model. The first test results reported are for the Classification Test (The Test column includes the value Classification). For each fold, the report includes values representing whether the model correctly predicted the Target State in each case. The number of Partition Indexes reported will be equal to the Fold Count value defined for the report. The Partition Size will be the Max Cases defined divided by the Fold Count defined.

Because we included a Target State of Yes in our definition, the Measure column can be interpreted as follows:
· When the Test Case value is Yes, and the model prediction is Yes, the Measure is reported as a True Positive.

· When the Test Case value is Yes, and the model prediction is No, the Measure is reported as a False Negative.

· When the Test Case value is No, and the model prediction is Yes, the Measure is reported as a False Positive.

· When the Test Case value is No, and the model prediction is No, the Measure is reported as a True Negative.

142. On the File menu, click Close Project. If prompted to save changes, click Yes.
Note: To deliver reliable and meaningful predictions, you should build multiple mining models and try different algorithms, parameters, and variables until you have identified the best model. This may require an iterative process of data preparation in which you add variables, transform values, and compare results by using the validation tools described in this exercise.
Exercise 3: Creating a Prediction Query
In this exercise, you will make predictions by using the Mining Model Prediction view of the Mining Structure Designer. This view will enable you to optimize the marketing plan by contacting those potential buyers who are most likely to make a purchase. The Prediction Query Designer enables you to create prediction queries through a graphical view or a SQL query view. The results of the prediction query created in this exercise will show the probability of each potential customer buying a bike. You can also use Reporting Services to provide a more robust report based on the prediction query created in this exercise.
Note: This exercise requires the views that were created at the beginning of exercise 1.

Open and deploy an existing project
143. Open Business Intelligence Development Studio if it is not already open.

144. On the File menu, point to Open, and then click Project/Solution.

145. In the Open Project dialog box, browse to C:\SQLHOLS\Data Mining\DM Exercise 3, click DM Exercise 3.sln, and then click Open.

Important: The solution used in Exercise 3 is different from the solution created in Exercise 2.

146. On the Build menu, click Deploy DM Exercise 3.

147. Observe the deployment progress shown in the Deployment Progress window. The Deployment Progress pane gives you detailed information about what happens during deployment.

Note: Analysis Services may take a while to process the data-mining models.

148. When deployment is complete, you can close the Deployment Progress window if you want.
Select the mining model and input table for a prediction query
149. In Solution Explorer, in the Mining Structures folder, double-click Customers.dmm.

Tip: If Solution Explorer is not visible, click View, and then click Solution Explorer.

150. In the Customers.dmm designer, click the Mining Model Prediction tab.

151. In the Mining Model window, click Select Model.

152. In the Select Mining Model dialog box, expand Customers, click Customers DT, and then click OK.

153. In the Select Input Table(s) window, click Select Case Table.

154. In the Select Table window, in the Data Source box, ensure that Customers is selected, click the vDMLabCustomerPredict table, and then click OK.

Note: Relationships between the mining structure and the input table are automatically created between columns with the same name. Relationships can be added or deleted by the user.

Build the Decision Tree prediction query

155. Enter the following values into the first row of the table at the bottom of the designer.
	Columns
	Values

	Source
	vDMLabCustomerPredicts

	Field
	CustomerKey

	Show
	(Checked)


Tip: You can resize the columns of the table by dragging the dividing line between the column headings.

156. Enter the following values into the second row of the table.
	Columns
	Values

	Source
	vDMLabCustomerPredicts

	Field
	FirstName

	Show
	(Checked)


157. Enter the following values into the third row of the table.
	Columns
	Values

	Source
	vDMLabCustomerPredicts

	Field
	LastName

	Show
	(Checked)


Note: Adding the customer’s name to the report will make the report more readable and useful for users. If the view or table defined in the Data Source View contained additional information such as phone number or e-mail address, these columns can also be added to the report, giving the company a report created in a single step that included all contact information required by the marketing department.
158. Enter the following values into the fourth row of the table.
	Columns
	Values

	Source
	Customers DT mining model

	Field
	Bike Buyer

	Show
	(Checked)


Note: The value in the Source column will change from Customers DT mining model to Customers DT.

159. Enter the following values into the fifth row of the table.
	Columns
	Values

	Source
	Prediction Function

	Field
	Predict Probability

	Alias
	Confidence

	Show
	(Checked)

	Criteria/arguments
	[Customers DT].[Bike Buyer]


160. On the Mining Model menu, click Query to view the Data Mining Extensions to SQL language (DMX) syntax for the query that you defined in the previous steps. DMX is designed to create, train, modify and query data-mining models, providing a simple and familiar language for embedding prediction in applications.
Display the Decision Tree query results

161. On the Mining Model menu, click Result to view the results of the query that you defined in the previous steps.
The results of the prediction query are displayed as follows:
· The CustomerKey column identifies each record from the input table.
· The FirstName and LastName columns show the name of each customer.
· The Bike Buyer column contains the mining model's prediction of the customer's bike-buying behavior.

· The Confidence column contains a value representing how certain the mining model is in the prediction contained in the Bike Buyer column. Larger values in the Confidence column represent a greater certainty that the prediction is correct.
Adventure Works can use the results of the prediction query to promote their bikes to those individuals most likely to purchase a bike. Adventure Works marketing expenses will be reduced because only potential customers who are likely to be bike buyers need be contacted. This ensures that marketing campaigns can be targeted more efficiently.
162. On the File menu, click Close Project. If prompted to save changes, click Yes.

Exercise 4: Creating a Time Series Model
The management at Adventure Works would like to predict sales of certain models of bikes in the future, based on the data that has been collected from previous sales. To assist with forecasting future sales, you will create a mining model based on the Microsoft Time Series algorithm.

In this exercise, you will create and view a Time Series data mining model. Data mining in SQL Server 2008 supports both the ARTXP algorithm which is developed by Microsoft Research and optimized to predict the next likely value in a series and SQL Server 2008 adds support for the ARIMA algorithm which improves accuracy for long-term predictions.
Note: This exercise requires the views that were created at the beginning of exercise 1.

Create an Analysis Services project
163. Open Business Intelligence Development Studio if it is not already open.
164. On the File menu, point to New, and then click Project.

165. In the New Project dialog box, in the Project Types pane, click the Business Intelligence Projects folder.

166. In the Templates pane, click Analysis Services Project.
167. In the Name box, type DM Exercise 4
168. In the Location box, enter C:\SQLHOLS\Data Mining\Starter\
169. Clear the Create directory for Solution checkbox.

170. Click OK.

171. In Solution Explorer, right-click the DM Exercise 4 project, and then click Properties.

172. In the DM Exercise 4 Property Pages dialog box, under Configuration Properties, click Deployment.
173. In the right pane, in the Deployment Mode drop-down list, click DeployAll, and then click OK.
Create a data source

174. In the Solution Explorer window, under the DM Exercise 4 project, right-click the Data Sources folder, and on the shortcut menu, click New Data Source.

175. In the Data Source Wizard dialog box, on the Welcome to the Data Source Wizard page, click Next.

Tip: If the Data connections pane already includes (local).AdventureWorksDW, move to step 10.

176. On the Select how to define the connection page, ensure the Create a data source based on an existing or new connection option is selected, and then click New.

177. In the Connection Manager dialog box, click the SqlClient Data Provider from the .Net Providers folder in the Provider drop-down list at the top of the page and click OK.

178. In the Server name box, type (local)
179. Under Log on to the server, click Use Windows Authentication.
180. In the Select or enter a database name drop-down list, click AdventureWorksDW.

181. Click Test Connection, and then click OK to dismiss the message box.

182. In the Connection Manager dialog box, click OK.

183. In the Data Source Wizard dialog box, on the Select how to define the connection page, verify that (local).AdventureWorksDW is selected, and then click Next.

184. On the Impersonation Information page, select Use the service account, and then click Next.

185. On the Completing the Data Source Wizard page, leave the default data source name Adventure Works DW unchanged, and then click Finish.

Create a Data Source View
186. In Solution Explorer, under the DM Exercise 4 project, right-click the Data Source Views folder, and click New Data Source View.

187. In the Data Source View Wizard dialog box, on the Welcome to the Data Source View Wizard page, click Next.
188. On the Select Data Source page, in the Relational data sources pane, verify that Adventure Works DW is selected, and then click Next.
Note: At this point, Analysis Services might take a few moments to read the database schema.
189. In this project, your Data Source View is not based on a table; instead, it is based on a view. On the Select Tables and Views page, double-click vTimeSeries to add this table to the Included objects list, and then click Next.
190. On the Completing the Wizard page, in the Name box, type FutureSales and then click Finish. The Data Source View Designer will open. The Data Source View Designer is a graphical representation of the data schema that you have defined.
191. Right-click the vTimeSeries table, and then click Explore Data.
Note: Analysis Services might take a few moments to read the data.

192. This opens a new window in which you can view the data for the table. Review the data in the view and note that the data is stored on a monthly basis. You will use this information in the next procedure to inform the algorithm that our data pattern repeats itself every 12 periods (months). You will rename the Quantity and Amount columns to clarify the meaning of the data when viewing the data mining model.
193. In the FutureSales.dsv design window, in the Tables pane, under vTimeSeries, right-click the Amount column, and then click Properties.
194. In the Properties pane, change the FriendlyName to Sales Amount.
195. In the FutureSales.dsv design window, in the Tables pane, right-click the Quantity column, and then click Properties.

196. In the Properties pane, change the FriendlyName to Units Sold.

Create a Data Mining Structure

197. In Solution Explorer, under the DM Exercise 4 database, right-click the Mining Structures folder, and then click New Mining Structure.

198. In the Data Mining Wizard, on the Welcome to the Data Mining Wizard page, click Next.
199. On the Select the Definition Method page, click From existing relational database or data warehouse, and then click Next.
200. On the Create the Data Mining Structure page, under the Create mining structure with a mining model option, in the Which data mining technique do you want to use list, click Microsoft Time Series, and then click Next.
201. On the Select Data Source View page, in the Available data source views pane, verify that the FutureSales data source view is selected, and then click Next.
202. On the Specify Table Types page, in the Input tables pane, in the vTimeSeries row, verify that the Case check box is selected, and then click Next.
203. On the Specify the Training Data page, in the Mining model structure pane, select the Key check boxes for the Time Index and Model Region columns, select the Input and Predictable check boxes for the Quantity column, and then click Next.
204. On the Specify Columns’ Content and Data Type page, review the default content and data types, and then click Next.

205. On the Completing the Wizard page, change the Mining structure name to SalesForecast, and then click Finish.
Modify a Mining Structure and Model

206. On the Mining Structure page, right-click Columns under the SalesForecast structure, and then click Add a Column.
207. On the Select a Column page, click Sales Amount as the Source column, and then click OK.
208. In the SalesForecast pane, under Columns, right click Amount, and then click Properties.

209. In the Basic section, change the Name to Sales Amount and then press ENTER. In the Microsoft Visual Studio warning box that appears, click Yes to change the name in all related mining model columns.

210. In the SalesForecast pane, under Columns, right click Quantity, and then click Properties.

211. In the Basic section, change the Name to Units Sold and then press ENTER. In the Microsoft Visual Studio warning box that appears, click Yes to change the name in all related mining model columns as well.
212. In the designer window, click the Mining Models tab.
213. Set the Sales Amount column to Predict for the vTimeSeries model. This will set the Sales Amount value to be used as both input and predicted values.

214. Right-click the vTimeSeries model, and then click Set Algorithm Parameters.

215. On the Algorithm Parameters page, review the parameters and default values.

Note: The FORECAST_METHOD parameter defines which algorithm(s) will be used to provide the forecasting. The default value is MIXED. With this setting, Analysis Services uses each algorithm separately to train the data and then combines the results to yield the best prediction possible. The PREDICTION_SMOOTHING parameter can be used to define whether the MIXED FORECAST_METHOD favors one algorithm over the other. If you are looking for short-term predictions, you can specify the ARTXP method. For longer-range predictions, you can specify the ARIMA method. These parameters and others are shown in Figure 3.
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Figure 3
216. Set the PERIODICITY_HINT Value to {12} and then click OK. The data in the data source is organized into monthly results. The PERIODICITY_HINT Value tells the algorithm that a pattern repeats itself every 12 periods (or months in this case).
Deploy the Analysis Services solution
217. On the Build menu, click Deploy DM Exercise 4.
218. Observe the deployment progress shown in the Deployment Progress pane. The Deployment Progress pane gives you detailed information about what happens during deployment.
Note: Analysis Services might take a while to process the data mining models.

View the Time Series mining model
219. Click the Mining Model Viewer tab.
220. Hide Solution Explorer and any other windows that are blocking the chart information by clicking the Auto Hide icon (the pushpin in the upper-right corner).

The chart shows the quantity and sales amount information for bike sales by region. The values from July 2001 to March 2004 are actual values and are shown as solid lines. The values for April 2004 and beyond are predicted values and are shown as dotted lines.
221. Point to any of the lines on the chart. A tooltip will appear and display information relevant to the location on the line.

222. Click in the chart where the chart background color changes to a darker shade of grey. The mining legend now shows the values related to that point in time. The timestamp at the top of the legend tells you the month that you are looking at. For example, Timestamp: 200406 is June 2004. The most recent data represented in the mining model input data is for June of 2004. The dashed data lines to the right of the line you clicked represent predicted future Sales Amounts and Units Sold.
223. To compare Sales Amount for three different product models in Europe, under the Prediction steps, in the drop-down list,  select only M200 Europe: Sales Amount, R250 Europe: Sales Amount, and T1000 Europe: Sales Amount. Then click OK.
224. Click in the chart where the chart background color changes to a darker shade of grey. Notice that the mining legend is updated for the new chart view. This chart makes it easy to see that in the European market, the outlook for the M200 model far exceeds the other models currently being sold.
225. On the File menu, click Exit. If prompted to save changes, click Yes.

226. Close Virtual PC and discard changes.
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